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Why this unit matters
Every year we save more and more information on computer systems and the need for data storage capacity 
keeps increasing. Data files, records, pictures, music, films, games and applications all require storage space. 
A few years ago, we only kept a few files on our computers, but we are now using computers at home, work 
and school.

Your practical task
You work for a new international bank called Abacus. The business prides itself on using the latest 
technological advances and incorporating them into its high street branches all around the world. You are 
responsible for making sure that computer information is stored and backed up at each branch and for 
ensuring that all staff are kept up-to-date with the methods used. Banking information is highly confidential 
and the risks to security, should any data be lost, are taken very seriously. Employees must use storage and 
backup methods correctly, and training documents are regularly produced.

You have been asked to:
�  produce a training document for staff involved with storing and backing up data; it explains the different 

devices, media and methods available
� create a simple spreadsheet and chart that compares the storage capacities of different devices
� create an additional leaflet explaining electronic banking methods to new employees.

I use a high-resolution digital SLR camera for still images and a dedicated high 
definition video camera for video. Both of these devices capture imagery at very 

high resolution, providing lots of detail but creating very large computer files. 
I need high capacity memory cards and computer drives to store and access 

my work. (Professional digital photographer)

Customers are often unsure about how much storage they need and want 
advice on the best way to back up their files. The advice we give must be 

based on the needs of the user. For example, a young family with a computer 
full of photos, videos and games will need more storage capacity than an 
author writing a book using a word processor. (Computer store manager)

From high resolution X-rays to patient records and training documents, lots of 
information is now stored on computers, making information easier to access 

from anywhere in the hospital. This information must be electronically secure from 
unauthorized access and backed up. If any of the original computer information is 

lost, another copy must be made available quickly. (Hospital worker)

3  Storage devices and media
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By the end of this unit you will be 
able to:
� describe a variety of storage devices and 

media, together with common uses for each

� explain the advantages and disadvantages of 
different methods in terms of speed, access, 
use and cost

� understand the importance of regularly backing 
up data

� describe the various electronic methods and 
communication systems used in banking today.

In your practical work, you will 
develop and apply skills in:
� communicating using document 

production skills

� document creation; combining text, images and 
graphical elements in your work

� creating and using a simple spreadsheet model

� saving, checking and printing your work

� using file compression to assist with storage 
and electronic transmission.

What this unit covers
THEORY
Sessions

3.1 Storage devices and media

3.2 The importance of data backup

3.3 Banking facilities today

Theory review

PRACTICAL

Sessions

3.4 Document preparation

3.5 Adding text and images to a document

3.6 Creating a simple data model and chart

3.7 Final document checks and presentation

Practical review
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Background
In this session, you will look at the many different storage devices and media used today, as well as their 
uses, capacities and differences.

The difference between storage devices and media
A storage device is something that has the ability to read and write information to and from storage media, 
for example, a CD/DVD writer or tape drive. The components that store the information, such as 
CD/DVDs, hard disks and memory cards, are storage media.

Storage technology
The technology used in modern storage devices and media comes in three varieties, each with its own 
characteristics.
� Magnetic: stores data in tiny magnetic dots on a disk or tape, organised to store binary data. 
� Optical: uses a laser to read, and write, a binary dot pattern on a spinning disc.
� Solid State: uses non-volatile memory chips to store data electronically with no moving parts.

Write a list of all the things at home – not just computers – that you think can store electronic information. Compare and discuss 
your answers with a friend.

Activity 1

Storage devices and media: their advantages and disadvantages

Description Advantages Disadvantages

Fixed magnetic hard disks: 
found in most computers 
as the main storage device. 
Use complex magnetic 
components.

Storage device using 
direct access

� Their capacity is constantly 
increasing as prices are 
decreasing.

� Fast access; data can be read 
from any part of the disk (this 
is known as random access).

� Due to their mechanical 
complexity, physical 
errors are extremely 
difficult to fix.

� Limited life span; data 
should be transferred 
every few years.

� Slightly slower to access 
than internal memory.

Portable magnetic hard disk 
drives: a portable version 
of the hard disk. Ideal for 
transferring data from one 
computer to another and 
also used to increase a 
system’s storage capacity. 
Also known as a removable 
hard disk drive. 

Storage device using direct 
access

� They can often be powered 
using the connecting USB 
cable.

� Portable hard disk drives add 
extra storage capacity to a 
computer without having to 
open the computer casing.

� Similar to a larger hard 
disk; difficult to repair and 
a limited life span.

� Slightly slower to access 
than internal memory.

� Capacity is not as large 
as a standard hard disk.

Magnetic tapes: used most 
commonly for large scale 
data storage and backup. 

Storage media using serial 
or sequential access

� A low cost way of storing 
hundreds of gigabytes of data.

� Information can be set to 
back up overnight or outside 
of office hours.

� Tapes are portable and can be 
stored safely.

� A special drive is required 
to read and write data to 
them.

� Access is much slower 
than a normal hard 
drive. (Serial access, see 
page 112)

� Not really practical for 
day-to-day storage and 
retrieval.

SESSION 3.1  Storage devices and media
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Optical CD/DVD: optical 
disk, normally used in retail 
for music releases and 
films to be played on home 
entertainment systems.

Storage media using direct 
access

� Low cost due to mass 
production.

� A world-wide standard; both 
CD and DVD players are 
widely available.

� No moving parts and require 
no power supply.

� Long lifespan if stored 
carefully.

� Scratches can make 
them unreadable.

� Information is read-only.

CD/DVD-ROM: optical disk, 
used to store commercial 
computer software such as 
an encyclopaedia, game or 
installation disk. 

Storage media using direct 
access

� Similar to that of CD/DVD 
disks.

� Large software packages can 
be easily distributed.

� Similar to that of CD/DVD 
disks.

� If damaged, software 
must usually be 
purchased again.

CD/DVD-R (Media): optical 
disk that can be written with 
data or media files once 
only. Used for backups and 
writing music CDs. 

Storage media using direct 
access

� Low cost due to mass 
production.

� Most computers have the 
ability to read and write disks.

� A long lifespan; some 
manufacturers claiming at least 
50 years.

� Disks can be left open and 
added to until they are full.

� Similar to that of CD/DVD 
disks.

� Errors can occur during 
writing, making the disk 
unusable.

� Data cannot be erased.

CD/DVD-RW: optical disk 
that can be written with 
computer or media files, 
erased and used again. 

Storage media using direct 
access

� Similar to that of CD/DVD-R 
disks.

� Each part of the disk can 
be erased and rewritten 
hundreds of times.

� Lifespan is thought not 
to be as long as other 
optical disks.

� Disks may stop working 
due to repetitive erasing 
and rewriting.

� Not all disk players can 
play rewritable disks.

DVD-RAM: similar to a 
DVD-R but designed to be 
more robust, with quicker 
access. 

Storage media using direct 
access

� Rewritable and protected 
from damage in a plastic 
case.

� Designed and manufactured 
to a higher standard than 
standard CD/DVD-RW to last 
longer.

� More expensive than 
standard optical disks.

� Less compatible with 
household players.

� Slower to write than 
standard writable disks.

Blu-ray: a high-capacity 
optical disk used for high-
definition movies, computer 
and console games, and 
data backup.

Storage media using direct 
access

� Able to store full-length high-
definition films and modern 
computer and console 
games.

� Up to 10 times the capacity 
of DVD disks.

� Disks very difficult to copy, 
preventing piracy.

� Writable Blu-ray 
disks are expensive 
and require a Blu-ray 
compatible drive.

� Commercial usage 
limited to entertainment 
media.

� Blu-ray content more 
expensive than standard 
DVDs.

� Already being replaced 
by Ultra HD Blu-ray.
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Solid state memory: 
uses microchips to store 
information with no moving 
parts; found in portable 
drives and memory cards.

Storage media using direct 
access

� Less susceptible to shock 
and damage.

� Silent.
� Faster read and write times 

than standard hard disks.
� Used as a high-speed 

replacement for magnetic 
storage.

� Ideal for portable devices.

� Practically impossible to 
repair if damaged.

� Lower storage 
capabilities than hard 
disks.

� Price per gigabyte of 
storage is higher than 
hard disks.

� Vulnerable to electrical or 
magnetic interference.

Pen drives: extremely 
portable solid state memory 
storage devices; designed 
to plug into the widely used 
USB port.

Storage media using direct 
access

� Ideal for pocket and key-ring 
size devices.

� USB sockets are found on 
the majority of computers.

� Require no additional power.

� Similar to that of all solid 
state drives.

� Can be easily misplaced 
or lost.

Flash memory cards: used 
to expand storage in smart 
devices, games consoles 
and digital still/video 
cameras.

Storage media using direct 
access

� Thumbnail-sized cards 
becoming common place.

� Cost-effective way of adding 
additional storage to devices 
with limited storage.

� Common standards include 
SD, MicroSD, xD and CFast.

� Smaller micro-style cards 
are easy to lose.

� Many different models, 
each with slightly 
different connectors.

Describing storage devices and media
Different devices access and use memory in different ways. The following terms may be referred to when 
describing storage devices and media.

Main or internal memory: Memory used by a computer system when processing or storing information. 
Random Access Memory (RAM) can be read and written to while using programs; the more RAM a system 
has, the faster it will run. Read Only Memory (ROM) holds permanent data that cannot be changed; it is 
normally used to store the essential program drivers (or firmware) needed to start your computer.

Backing storage: Any type of data storage device apart from RAM or ROM. This includes the hard disk drive 
found inside most PCs and normally used to store data permanently, even when the computer is turned off.

Serial or sequential access: Data is stored in a sequential sequence so that information stored can only be 
accessed by scanning through the data to that point. Tapes are an example of this type of storage.

Direct/random access: Any piece of information stored on a random 
access device can be accessed without having to scan through its 
whole contents. This is much faster than serial access.

Connectivity: Many computers may use an internal drive to read 
storage media, but external devices can also be connected by USB, 
USB-C, FireWire, Ethernet cables or by using Wi-Fi networking.

Access speeds: This is how quickly a user can access the information 
on any storage device. Access speeds are measured in ‘bytes per 
second’ (Bps) with slower devices measured in thousands (KBps) and 
faster devices using millions (MBps). A user’s choice of device may 
depend on how quickly they need to access data. Individual device 
speeds vary but generally speaking the following is true:
� Magnetic tape drives: Slow to access as the drive has to fast-

forward or rewind to the required section.
� Optical storage: A modern compact disk will have an access speed 

of about 8 MBps, DVD about 20 MBps and Blu-ray disks 18 MBps.

The lifespan of any new technology 
is notoriously difficult to predict, as 
long-term tests are rarely done before 
it is put on sale. If a device has only 
been around for a few years, it is not 
certain how long it will work or keep 
the information that it stores. One 
thing that is agreed upon is that no 
one method should be relied upon as 
a permanent solution. A DVD-R can 
hold seven times the amount of data 
as a CD-R, and Blu-ray disks can store 
10 times that of a DVD. Who knows 
what the next development will be?

Real world
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� Solid state based storage: As there are no moving parts and flash based memory is much quicker to 
read and write, access speeds of over 500 MBps are possible.

Storage capacity
The table below provides some typical capacities, but it should be noted that hard disks and solid state 
drives are constantly increasing in storage capacity.

Storage device or media Typical capacities (at the time of 
publication)

CD* 700 megabytes (MB)

DVD* 4.7 or 8.54 gigabytes (GB) (single or dual 
layer)

DVD RAM* 4.7 or 9.4 GB (single or dual layer)

Blu-ray* 25 or 50 GB (single or dual layer)

Pen drive** 2–64 GB

Flash memory cards** 2–64 GB

Portable disk drive** 320 GB–4TB

Solid state drive** 500 GB–2 TB

Magnetic disk drive** 1–8 TB

Magnetic tape** 500 GB to 5 TB

* Generally fixed manufacturing standards

** These capacities are constantly being increased as manufacturing 
techniques develop.

File sizes
When matching usage to storage devices, it is important to consider 
approximate sizes for different types of files.

8 bits 1 byte Word processed 
document

100 KB

1024 bytes 1 kilobyte (KB) eBook 500 KB

1024 kilobytes 1 megabyte (MB) Mp3 track 5 MB

1024 megabytes 1 gigabyte (GB) Digital photo 3 MB

1024 gigabytes 1 terabyte (TB) Film 1.2 GB

1 Create a short survey and ask classmates or friends to estimate how many of each of the following types of files they own 
electronically:

music tracks, eBooks, films, digital photos, office documents.

2 Combine your survey results with the approximate sizes above to estimate how much information the people you surveyed 
own. Which devices would be the most appropriate to store the data they own?

Activity 2

Every year we increase the amount 
of data we store; documents, photos, 
videos, games and music. This means 
file compression, using ZIP and RAR 
utilities is increasingly useful for 
storing and archiving files or reducing 
file sizes when emailing.

Real world

There are many types of memory 
cards available today, and different 
manufacturers often create their own 
for a specific type of device. Look at 
the devices that you and your friends 
own, from cameras to mobile phones 
and portable gaming machines – how 
many different types of memory card 
do you use?

Real world

Pen drives are sometimes referred to 
as USB or memory sticks.

Language
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It is important to choose the best device, based on the users’ needs and considering the characteristics, 
advantages and disadvantages of each. The diagram below illustrates the main considerations when 
choosing a suitable storage device.

Ease of use
Are additional devices

required to read the media,
for example, a tape

or CD drive?

Permanence
How long does the

information need to be
stored for, and can it

be stored safely?

Storage capacity
How much information
needs to be stored – 

megabytes or
terabytes?

Important
considerations

Speed of access
How often and  how

quickly does the
information need
to be accessed?

Using the storage considerations diagram as a guide, discuss in small groups the following situations, and decide on the best 
storage options.

1 Taking a report home to work on.

2 In an architect’s office, using CAD to create building plans and graphics software to see what new buildings might look like.

3 In a music recording studio, using computers to record and then edit multiple audio tracks, from singers to instruments and 
percussion.

Activity 3

You should now be able to:
� describe the most common forms of storage devices and related media
� identify common uses for storage devices, including types of access and access speeds
� consider the different capacities available and define the difference between main/internal memory and 

storage
� explain the advantages and disadvantages of different methods in terms of speed, access, use and 

cost.

Review and revise
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Background
The phrase ‘backing up’ essentially means making an extra copy of 
computer information so that, in the event of a problem, loss of the 
original file, or damage to the computer, the backup copy can be used 
as a replacement. This session will look at the importance of backing up 
data and the various methods available.

What should be backed up?
In an ideal world, if the cost of storage space was no object, every 
system would be backed up. A backup copy of your home computer 
would include the operating system, program files, personal 
documents, device drivers and everything else on your computer. 
Unfortunately this is not always possible, so a choice has to be made 
about what to back up. Operating systems can be re-installed from 
disks and programs can be downloaded again, but photographs of 
your holiday or that last school report you wrote could not be replaced 
without being re-created.

This is even more important for organisations. Hospitals and banks, for 
example, store important, private information – and if that information 
became lost or corrupted, then lives and businesses could be at risk.

Create a table with the following headings:
� School
� A graphic designer
� Designing the pages of a popular newspaper
� Hospital

For each heading, write a list of all the information you think would be important to back up, and describe what would happen if it 
were lost.

Activity 2

Backup models
The following are popular methods for backing up information.
� Manually choosing a selection of files to be saved onto a disk. 

This is useful for backing up a small selection of essential files. It is 
known as ‘an unstructured backup’.

� Creating a copy of every file, both personal documents and system 
files, stored on a computer hard drive in case of a serious failure. 
This is often called creating an ‘image’ of a computer. There are 
software tools that can do this, but it does take time, which means 
it isn’t suitable for regular use. This is referred to as ‘a full system 
backup’.

� After a full system backup, backups are made at regular intervals of 
whatever has changed since the initial and following backups. This 
means that only small amounts of information are regularly saved, 
and users can look back at a system at a specified date in the past. 
This is known as ‘an incremental backup’.

� If a fire burns down an office of computers and the backup drive is 
permanently plugged in, then it, too, will be lost. Using an off-site 
backup minimises the risk of losing data by making sure the drive or 
disks used are kept elsewhere, ideally in a secure location. This is 
called ‘an off-site backup’.

Think about the main computer in your 
home, or in a family member’s home. 
What kind of important information 
is stored on it? Create a list of what 
you come up with and then, in a small 
group, discuss what might happen if 
that information were suddenly lost.

Activity 1

There are manufacturers that claim to 
have created indestructible storage 
devices that can withstand fire, water, 
pressure and physical damage. These 
usually work by encasing the storage 
medium in a protective box.

Real world

Security concerns about the 
information we store has increased 
in recent years, especially as more 
and more personal data is being 
stored using cloud computing and 
therefore accessible via the internet. 
Data encryption scrambles computer 
files so that they can only be read 
with the correct encryption key.

Real world

SESSION 3.2  The importance of data backup
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Depending on the needs of the user, there are a number of solutions available, ranging from practical to 
commercial options.
� Manually copying files. This is often the simplest solution and involves plugging in a USB hard disk and 

copying files to it on a regular basis.
� Software backup. There are numerous software solutions that will copy selected files to a backup drive 

at a selected time. This prevents people from forgetting to backup and can be set to happen when the 
computer is not used – late at night, for example.

� Mirroring (often referred to as RAID). Two or more compatible 
hard disks are linked in such a way that information is written to 
them both at the same time, creating clones of each other. If one 
drive fails, the other is still accessible.

� Online or remote backup. Rather than backing up files to a 
physical device, files are backed up via the internet to an online 
server. This is usually done via third party software installed on a 
computer. There are many businesses that offer this service, and 
price is based on the amount of storage required and the number 
of access features. Storing files online is a key element of cloud 
computing.

Research and discuss with your class the backup facilities built into Windows, Apple and Linux operating systems and compare the 
features they offer to third party solutions.

Activity 3

You should now be able to:
� understand the importance of regularly backing up data
� explain a variety of methods for carrying out backups.

Review and revise

Cloud computing is the term for 
accessing computer files, documents 
and programs remotely, either via a 
network or more commonly via the 
internet. This takes away the need for 
local storage devices and information 
can be accessed almost anywhere.

Language
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Background

Modern banking terminology
� Electronic funds transfer (EFT). This is used for paying by Chip and 

PIN or contactless payment (see Session 2.2) in shops and transferring 
money from one bank account to another, anywhere in the world. It 
may be a regular bill payment or payroll deposits. These can either be 
set up in person or electronically. 

� Automated teller machine (ATM). Normally installed in public 
places, these installations have a direct communications link to a 
bank. They can release money and debit it from an account and 
can also manage some basic banking facilities. These include 
checking the balance or printing a mini-statement, paying bills 
or making money transfers. It is also possible to make cash and 
cheque deposits, usually by placing it in a specially provided 
envelope and sliding it into the ATM.

� Credit and debit cards. Used as an alternative to cash, this allows 
stores and organisations to debit money from an account for goods 
or services. Customers have a card and a PIN number. When the 
card is scanned and the PIN number entered correctly, it allows the 
store to contact the customer’s bank. If the customer has sufficient 
funds, then the amount is deducted from their account and credited 
to the store. Information about magnetic stripe, Chip and PIN 
devices and contactless payments can be found in Session 2.2.

� Cheques. Rather than using cash, a cheque allows money to be 
withdrawn from one account and deposited in another. It contains 
the name and account details of the sender and the full name of the 
recipient. Being a paper-based system, it is often claimed to be 
the slowest way to transfer money as it needs to be checked and 
‘cleared’ before money is transferred. 

Modern communication methods and banking
It is becoming less and less essential to actually visit bank branches. 
Checking and changing balances, paying bills or applying for new 
accounts can all be done from home or from the office.
� Telephone banking. Done via either a conversation with a banking 

call centre or an automated system that responds using voice 
recognition software or telephone keypad choices.

� Internet banking. Account details are accessed through a secure 
webpage that provides direct access to a full range of account 
functions from setting up transfers to paying bills to applying for 
new products, overdrafts and updating personal details. Secure 
login and password details must be setup before use.

� Mobile phone access. Applications (or apps) are increasingly being 
produced that give direct access to a particular bank and account 
details, providing almost instant access to information wherever you 
are, without the need for a computer and browser.

SESSION 3.3  Banking facilities today

Many businesses are now introducing 
contactless payment systems that 
allow an individual to wave a debit/
credit card or smart device over the 
reader that then automatically debits 
the users account. These are generally 
targeted at small value payments that 
would benefit from faster transactions 
such as queuing and paying for a 
coffee or snack. These systems use 
radio-frequency identification (RFID).

Real world
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Consider the following situations and describe the banking facilities that would be the most 
appropriate and why the different people might use them.

1 A university student living away from home.

2 An electronics store selling computers and mobile phones.

3 A retired couple who have moved to a remote rural house.

Activity 1

Advantages and disadvantages of modern electronic banking methods

Advantages Disadvantages

� Instant access without having to visit a branch in 
person.

� Money can be transferred instantaneously to 
anywhere in the world.

� Customers do not have to wait for monthly postal 
statements to check their balance and recent 
transactions.

� Banks can spot fraud activity more quickly by 
analysing patterns in your spending and online 
transactions.

� Additional functionality can be accessed online such 
as controlling overdraft levels, changing Chip and 
PIN codes or pay bills directly.

� Customers with limited mobility can access full 
services remotely.

� Identity theft is a real concern as banks rarely see 
customers in person.

� Mobile phone access requires a reliable data 
connection.

� Users are constantly sent spam emails, asking them 
to confirm, and therefore, give away login details. 
This is called phishing.

� Those without internet access often miss out on the 
latest deals and interest rates.

� Transactions using physical currency such as cash 
and cheques cannot be made.

� An internet-based bank could potentially be closed 
at any time due to technical problems.

What do you think are the biggest security problems associated with the systems 
outlined in this session? Discuss your thoughts with your classmates.

Activity 2

Considering the storage devices and media described in the previous sessions, list the types 
of information that a bank would have to store on a daily basis. In small groups, discuss and 
decide on the most appropriate storage devices and media. Explain your choices.

Activity 3

You should now be able to:
� describe the various electronic methods and communication systems used in banking today
� explain the advantages and disadvantages of different methods in terms of use and purpose.

Review and revise

Two-step verification is a system 
that requires two pieces of security 
data in order to access an online 
system, for example a password and 
an extra security code. This provides 
an extra level of protection should 
your password be lost or stolen and 
many ecommerce systems, including 
banks, require customers to use it.

Real world
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1  Draw lines to connect the images on the left 
with the best example of its use on the right.

Fixed hard disk

Storage device 
in a digital 
camera

Pen drive

Business 
wanting to take 
a weekly file 
backup

Memory card

A student 
transferring a 
homework file 
to the school 
network

Magnetic tape

The main 
backing 
storage device 
in a desktop 
computer

See Session 3.1

2  For each of the devices below, indicate with a 
tick whether it is a magnetic, optical or solid 
state device.

Magnetic Optical Solid state

Portable 
hard drive

DVD

RAM chip

DVD RAM

Tape

See Session 3.1

3  Link the media type on the left with its most 
appropriate use on the right.

Hard disk 
drive

Backup of files in 
a large commercial 
organisation

Magnetic tape Storing images in 
a camera

Flash memory Main storage in a 
desktop computer

Pen drive Storage of film or 
music files

CD/DVD Temporary storage 
and transfer of 
files between 
computers

See Session 3.1

Some practice questions

What have you covered?
In these three theory sessions, you have:
� been introduced to the most common forms of storage devices and related media
� explored the most common uses for different storage devices and their capacities
� considered the most suitable application for different capacities of storage devices
� discovered the difference between main and internal memory and storage
� reviewed the advantages and disadvantages of different storage methods in terms of 

speed, access, use and cost
� come to understand the importance of backing up data regularly
� been introduced to a variety of methods for carrying out backups
� explored the various electronic methods and communication systems used in banking today
� reviewed the advantages and disadvantages of different methods in terms of use and purpose.

3  Theory review
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4 a  A computer’s internal memory consists 
of RAM and ROM. Each has different 
characteristics and uses. Fill in the missing 
words with either RAM or ROM:

______ is non-volatile memory.

  When we are using a computer, the 
program we are using and the data we 
type in will be held in ______.

  The computer’s basic input output system 
(BIOS) will be stored in ______.

  When the computer is turned off the 
contents of ______ is lost.

b In the mid-1980s, personal computers had 
their operating system stored on ROM, so 
that as soon as you switched the computer 
on it was ready for use. Why do you think 
that today’s desktop computers do not have 
the latest operating systems on ROM, but 
instead have it on the computer’s hard disk?

See Session 3.2

5 Sergeiy runs a small business selling eBooks. 
Every week he runs a backup program.

a What is a backup?

b There are different types of backups, which 
depend on what exactly will be backed 
up. Sergeiy had a complete backup taken 
when he started this routine. Now his 
program just takes a copy of recently 
changed files. Give one advantage to 
Sergeiy of running a backup like this.

c Give two reasons why Sergeiy runs this 
program every week.

d Sergeiy receives an email from a company 
that offers a remote, or online, backup 
facility. The email tells him that for a yearly 
fee the company would hold copies of his 
files on their remote server. Sergeiy is not 
sure whether this backup service would 
be of use to him and asks for your advice. 
State the main reason that Sergeiy might 
want to make use of this service.

e State one reason that Sergeiy might 
choose not to use this service.

f How might Sergeiy still have the benefit of 
this type of backup, but without using a 
company like the one that contacted him?

See Session 3.2

6 a  Identify three ways that a person can 
check his or her bank account balance 
without having to go to the bank itself.

b Many people are concerned about the 
increasing use of technology in personal 
banking. The biggest concerns are security 
of personal information and access to 
information. Describe two ways in which 
the bank makes sure that the personal 
details of customers are secure.

c How does the bank make sure that only 
authorised people access customer 
details?

See Session 3.3

Progress check

Aiming for good progress
� You are able to identify the main types of 

storage devices.
� You can determine which type of storage device 

might be used for a given application.
� You can distinguish between the different types 

of internal memory.
� You can describe the different types of backup 

methods.

Aiming for excellent progress
� You can describe the main types of storage 

devices.
� You can justify the choice of a particular storage 

device for a given application.
� You can identify the uses of RAM and ROM.
� You can justify a choice of backup method, 

depending on the user’s requirements.
� You appreciate the concerns of bank customers 

regarding security of, and access to, personal 
details, and understand how the banking 
system addresses these concerns.
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Background
Working for an international bank called Abacus, you have been asked to produce a training document using 
suitable word processing software. This will inform the staff who are involved in backing up and storing data 
all about storage devices and media.

In this session, you will find out how to do the following:
� create a new document
� design a suitable page layout in keeping with the company house style
� save your work in a suitable format and location.

In the practical sessions throughout this unit you will reinforce and extend some document production skills.

Create a new document
In Session 1.7 you opened a document and imported data from existing files. In this unit you will create a 
new document. Shown below is a typical word processing package. Select File > New and you will get the 
following screen.

Although there are many 
different templates available 
within this program, you 
are going to create your 
own. Select the Blank 
document option and then 
select the Create button

Saving and file location
It is important that the file you have created has a suitable filename and location. This means that you can 
regularly save your work as you progress, and you will easily be able to find your work at a later date.

SESSION 3.4  Document preparation
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Set up a folder on your computer, and within 
it save a new blank document using 
suitable file and folder names.

Activity 1

Create a folder called 
LEAFLET within your work 
area. You will save all the 
files you create in this 
project inside this folder.

Using the filename Abacus leaflet, save your document into the 
folder you have just created. Select Save.

Designing a suitable page layout
Before adding information, it is important to set the page layout to suit the type of document you intend to 
produce. You will change the following properties of a document:
� page size, margins and 

orientation
� headers and footers � columns.

Page size and orientation
You can change the page size and orientation as follows:

Select Page Layout
then Page Setup. This 
will take you to the 
Page Setup window.

Then choose the 
Paper option to 
select the size of 
document you 
intend to create.

30924_P108_145.indd   122 23/08/21   4:27 PM



12
3

S
es

si
on

 3
.4

  D
oc

um
en

t 
p

re
p

ar
at

io
n

P
R

A
C

T
IC

A
L
 

Using the Page Setup options, choose a suitable paper size for your document. This 
should be based on the size of paper and printer to which you have access.

Activity 2

Selecting the Margins option allows you to set the orientation of the 
document. The Portrait option will produce a tall, narrow document 
and the Landscape option will turn the page through 90 degrees to 
create a short, wider document.

The working area on any page is set using the Margin options. These 
settings adjust the space around the edge of every page in your 
documents.

Set suitable page orientation and margin settings for your document, bearing in mind 
the type of document you are creating and your printing facilities.

Activity 3

Headers and footers
Information added to the header (top) and footer (bottom) of any 
document will appear on every page of the document. They can be used to style a document and include the 
following types of information:
� titles, text and images
� page numbering
� file information
� current or document creation date.

Double clicking at the top of the page will open the header area. This is where a suitable document title can 
be added and formatted.

Alternatively select Insert from the ribbon and Header or Footer.

Standard formatting 
tools can be used 
to change the font, 
alignment and style.

Add a suitable title to your document using the header options and format it in the style of a modern banking business.

Activity 4

When creating documents that use 
columns, as in the task you have been 
set, the Portrait option is normally 
used.

Tip

Setting these options to zero will 
allow text and graphics to go right 
to the edge. However, most non-
commercial printers cannot print 
to the very edge and so require the 
page to have a minimum margin. 
Documents are often cropped after 
printing so that printing appears to go 
to the very edge. Bear this in mind.

Tip
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As headers are normally used for adding titles, additional information can be added to the footer as shown 
below.

Select the style of numbering 
and what number to start at.

The Field
option allows a variety 
of information to be 
added, including the 
Filename and Path
shown.

The Update 
automatically
option will constantly 
change to the current 
date rather than the 
creation date.

Text can be formatted using the formatting toolbar or by right clicking the text. The different fields can be 
spaced as shown by clicking the Tab button on your keyboard.

Page number

Filename

Author’s name

Tab

Creation date

Using the Footer options shown, add the following to your document and style them accordingly: your name; the date; automatic 
page numbering; the filename and path.

Activity 5
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Using columns
Columns, as you learnt in Session 1.8, are used to vertically divide a page before adding text, graphics and 
images. This is how newspapers and magazines are normally laid out.

Select Columns from the Page Layout
menu and choose the number required. 
To make more choices, select More 
Columns from the Columns button. 
Here the width of each column and the 
space between them can be adjusted.

The space between the columns is also 
referred to as the Gutter spacing in 
some software.

Add a suitable number of columns to your document, making sure you add sensible width and spacing values. Save your 
document.

Activity 6

You should now be able to:
� create a new document and save it with a suitable filename in a suitable location
� set the page size, margins and orientation of a document
� use the header and footer option to add useful information
� divide a document layout into columns.

Review and revise
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Background
In this session you will build upon and discover the following skills:
� accurately adding and formatting text
� using tables
� inserting images into a document.

Adding and formatting text
Typing text straight into a word processed document is the simplest way to add information, and there are a 
variety of formatting tools to help you to present it in the most suitable way.

Text formatting
Below are a selection of fonts, styles and sizes.

The Font window shown above can be found on the main menu or 
Formatting toolbar. The font, style and size of any selected font 
can be changed to suit the requirements of the document. Bold
or underlined headings, for example, are a good way of 
highlighting important information. Additional font effects 
include superscript, adding very small letters above the line 
of text and subscript, small letters just below.

Text alignment
The text on the right has been added to a document with two 
columns. The four paragraphs are aligned to the left margin, 
the right margin, centrally and fully justified (which means the 
text is spaced to meet both the left and right edges of the text 
area).

Serif and sans-serif fonts. When 
describing fonts, a serif typeface has 
detailing at the ends of strokes in 
letters, while sans-serif fonts do not. 
Serif fonts are normally thought of 
as being traditional styles, such as 
Times New Roman, while sans-serif 
fonts like Arial are considered more 
modern.

Language

A standard selection of fonts is 
installed on every computer but new 
ones can be installed and different 
computers may not have the same 
fonts. This should be considered when 
transferring work from one machine 
to another.

Tip

SESSION 3.5  Adding text and images
to a document
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Create a new word processing document and type the name of the organisation in this unit – Abacus International Bank – six 
times on the page. Using different fonts and styles, create what you think are three modern headings and three more traditional 
ones. Share your ideas with a partner and discuss which would be most suitable for this type of business.

Activity 1

Bulleted and numbered lists
Bullet points or numbered lists are useful for displaying different points of information. They can be accessed 
from the main menu or by right clicking within a text area. Right clicking a bullet point or number will allow 
you to format it using the options shown.

Paragraph formatting
The space before and after paragraphs, line spacing, and tab settings can be edited to suit the style of 
document. The Paragraph dialogue box and settings can be found by selecting Layout from the ribbon bar.

The Tab settings can be 
changed allowing you to 
set how far the cursor 
moves when pressing the 
Tab key.

Additional positions can 
be added here.

Indentation options allow the 
paragraph to be moved away 
from either the left or right hand 
margin. A hanging paragraph sets 
the first line to the left margin 
and the rest of the paragraph is 
indented.

Setting the Tabs of a page allows text 
to be formatted neatly try to avoid 
lining up text by pressing the 
space bar.

Tip

The spacing options allow text to be spaced 
vertically. The basic setting for line spacing is 
Single. These settings also allow the space 
before and after paragraphs to be specified.
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The following window outlines the options that are open to you when formatting documents.

Page break before forces a 
page break before any new 
paragraph.

Keep lines together 
prevents any paragraph from 
breaking across a page.

Widow/Orphan control
prevents a single word in a line 
of text being left on its own

Keep with next keeps a 
paragraph on the same page 
as the following paragraph.

Page, section and column breaks
At times, a break needs to be added to text before the actual end of the page or column. From the layout 
menu can be found the following options:
� Page break, where one page ends and another begins
� Section break, used to divide a document into sections
� Column break, where column text will stop and start again in the next column.

Using tables
Tables are used in word processed documents to present information 
in a structured way. They can hold text and/or images. The Insert 
Table dialogue box can be found by selecting Insert > Table.

How rows (horizontally) and columns (vertical) are set will depend on 
the amount of information that is to be added. The width can be set 
to fill the area where it is inserted, automatically, or a set width can be 
added.

Right clicking and selecting Insert within a cell allows extra rows and 
columns to be added. Similarly, selecting Delete Cells allows a row or 
column to be deleted.

Right click on the icon 
at the top left of the 
table to access the table 
properties. The border, 
fill and style of the table 
can now be edited.

The icon on the top 
left of a table is the 
handle to select and 
move it. It may be necessary to merge two or more 

cells for a heading or title. To do this, click 
and hold the cursor in one cell and make a 
selection of other cells. Then select Merge 
Cells from the Layout menu. 

The tools demonstrated for 
formatting text work exactly 
the same whether text is typed 
directly onto a page or it is pasted 
into a text box, table or shape.

Tip
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Open the Abacus leaflet document you created in Session 3.4 and write a short introduction. Remember the requirements of the 
document – to provide training information on storage devices and media and their relative advantages and disadvantages for use. 
Format the text using the skills learned in this session.

Activity 2

Inserting images into a document
As already demonstrated in Units 1 and 2, images can be inserted into 
a document from many different sources. They may be stored on a 
CD-ROM of images, saved into a documents area on the computer or 
imported directly from a digital camera or scanner.

The process and skills for inserting an image into a document (as you 
covered in Session 1.9) is very similar to inserting an image into a 
presentation (Session 2.7). These two sessions also demonstrated how 
to edit and adjust images once they have been added, for example, text 
wrapping to combine text and images.

Insert images of storage devices and media into your Abacus leaflet document 
after referring to the list of devices in Session 3.1. If you need a recap on internet 
searching and saving files from the internet, refer to Session 1.8. You need to 
consider the following when doing this.
� How many images can be placed in each column without overcrowding it?
� Each image will need space around it to enable you to add a title and text.
� Make sure there is no overlapping of information in the header or footer.

Make sure you keep saving your work as you progress through the project.

Activity 3

Hyperlinks and bookmarks
Hyperlinks are links from one file to another, this can be on the same 
computer or across the internet. When creating a leaflet a hyperlink 
can be used to add a link to a website for further reading. To add a 
Wikipedia page link to the text ‘Uses solid state memory’, simply 
select the text, choose Insert and Link from the main ribbon and add a 
website address as shown.

Many words that sound the same 
have two spellings; disc and disk for 
example. This will not be picked up by 
the spelling tool. A useful tool find a 
specific word and replace it is the Find 
and Replace tool.

Tip

Hyperlinks to an external file or 
website can be added to any object; 
text, images or graphic, in most office-
based programs.

Tip
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A bookmark is a saved location within a document. This can be useful in a document of more than one page, 
and links to a bookmark can be selected as destinations for a hyperlink. Simply select a word or object and 
select Insert and Bookmark from the main ribbon. Give the bookmark a name and then this can be selected 
from the hyperlink options window.

Using the information provided in this unit, and your own additional research, add the following to your leaflet:
� advantages and disadvantages of each type of storage device or media
� hyperlinks to useful research websites
� bookmarks to each section
� a short list of topics at the beginning of the leaflet to add bookmark links to.

Activity 4

You should now be able to:
� enter and edit text and images
� change the font, style and size of text to suit the style of document you are creating
� format text using alignment, line spacing and paragraph tools
� create, edit and complete tables
� position text and images within any document
� add internal bookmark locations and hyperlinks to external websites and files.

Review and revise
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Background
Working for Abacus International Bank, you have been asked to create a simple spreadsheet model and chart 
that can be used to calculate the available storage based on the number of devices and media available. The 
chart can also be imported into your training document.

In this session, you will find out how to do the following:
� use basic spreadsheet skills
� create a basic model using appropriate page layout, and using the 

header and footer
� add accurate data to create a simple chart
� print your work showing values and formulae
� import your chart into your training document
� save your work in a suitable format and location.

Creating a new document
Below is a common spreadsheet package. Select File > New and you will get the following screen.

Although there are many different 
templates available within the 
program, you are going to create 
your own, so select the Blank
workbook button.

Saving and file location
As already discussed in previous pages, it is important that all files you create have a suitable filename and 
location. This means that you can regularly save your work as you progress and you will easily be able to find 
your work at a later date.

Create a folder called SPREADSHEET MODEL within your document area. 
You will save all the files you create in this project inside this folder.

Data models: basic principles
Before creating your spreadsheet the following steps will guide you through the 
basics skills required.

There is a reference chart on the 
digital download (in the Extra 
support folder) with an overview of 
spreadsheet features and functions.

Tip

SESSION 3.6   Creating a simple data model and 
chart
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Spreadsheets are made up of the following:
� Columns: go up and down.
� Rows: go across.
� Cells: are where the columns and rows cross.

We refer to cells by their column and row reference.

Where the cell in a spreadsheet is surrounded by a dark band it is known as 
the active cell. This means that anything you type in will go into that cell – 
because it is active.

The active cell in the spreadsheet image on the top right of this page is 
cell A1.

1 In which column are the dates of birth?

2 In what row can you find Billie Brown’s data?

3 What is the cell reference for Hassan?

4 What is the cell reference of the active cell?

Activity 1

In what row can you find Billie Brown’s data?

In the cells 
Cells can contain:
� a number � a text label � a formula or function.

The spreadsheet program will recognise the difference between numbers and text. It needs help to recognise 
a formula, though. To type in a formula you will need to begin with the = symbol.

1 Open your spreadsheet program to begin a new sheet.

2 Type in the words Multiplication Table in cell A1.

3 Put the numbers 1 to 12 in cells B1 to M1.

4 In cell A2 put the number 1.

5 In cell A3 put the number 2.

6 Make cell B2 the active cell by clicking on it.

7 Type in this formula: =B1*A2.

8 Now complete the rest of the cells adding a formula to each.

9 If you have added the correct formulae it should look like the example below.

Activity 2

In spreadsheet software, simple 
mathematical symbols are 
represented by the following 
keyboard characters:

Equals: =

Add: +

Subtract: –

Multiply: *

Divide: /

Tip
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Changing the width of a column
Cell A1 is not wide enough to show all the characters in the cell. This means that you have to make it wider in 
order to see everything.

Double click on the line 
between columns A and B.

This makes sure that each cell is wide enough for the characters that need to be shown.

Save your work as Multiplication Table – Your Initials – The Date. Your filename should look similar to this: Multiplication 
Table – ACJ – 13June21.xlsx. Make sure you save this in your SPREADSHEET MODEL folder.

Activity 3

Page setup and using the header and footer
The following steps will show you how to change the page size, 
orientation and add information to the header and footer.

Select Page Layout > Page Setup.

Here you can set the 
paper orientation, size 
of margins and footer 
options.

Inserting and deleting rows and columns
Occasionally, you might need to add or remove an additional row or column. This might be just to improve the 
layout or a column may have been missed with creating a table. The Insert and Delete cells options can be found 
on the main ribbon. Alternatively, right click on the column letter or row number where you wish to edit cells.

Editing these settings is very similar in 
the majority of  office-based software.

Tip
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Merging cells
Depending on the layout of a table, it may be necessary to merge two 
or more cells together. The merged cells then behave as one single cell.

Selecting Header/Footer allows the header and footer to be customised with the following options:
� custom text
� page numbering
� inserting date and time

� filename and location
� inserting an image.

In the document you created in Activities 2 and 3, experiment with and add the following:
� Suitable page layout, orientation and margin settings for your document. Keep in mind the printing facilities which you have 

access to.
� Add the title Multiplication Table to the header, plus your name and any suitable additional information to the footer.

Activity 4

Creating a simple model and chart
The following steps will show you how to create a simple model and chart that represents the storage 
capacity of different devices and media you looked at in Session 3.1. This can then be inserted into your 
training document Abacus leaflet from Sessions 3.4 and 3.5.

A simple formula
=F2+F3+F4+F6+F7+F8+F10+F11+F12+F13

The program knows that it is a formula because you have inserted the = symbol at the beginning. But this 
is a long way round of inputting a formula.
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Merging cells within a table using 
lots of formulas can cause problems. 
Merged cells can normally be 
unmerged using the same toolbar.

Tip
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Functions
Most spreadsheet programs have functions. These allow you to bypass writing out complicated formulae by 
using the cell references and mathematical operators.

The functions you need to know about are structured like this:

=FUNCTION(F2:F13)
Begin the formula.

Type in the name 
of the function.

Open brackets and enter 
the cell reference of the 
first cell in the sequence.

The colon tells the program to 
go from the first cell ALL THE 
WAY THROUGH TO the last cell.

Enter the cell 
reference of the 
last cell in the 
sequence and 
close the brackets.

For the following model you want to use the SUM function.

=SUM(F2:F13)

Using multiplication formulae and the SUM function, create a simple spreadsheet model as a table that calculates the total storage 
capacity based on the quantities of each device or media. The headings for columns and rows are provided in this table.

Activity 5

The chart function
Data within a spreadsheet model can be represented visually as a chart or graph. 

A bar or column chart of some sort would be the most suitable way to represent this data.

Select only the data that is relevant (including headings as shown below) and then chose a chart from the 
Insert menu. The example shown is a 3D column chart.
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Customising graphs and charts
Once created, a chart can be customised to user requirements or to match the style of a larger document. 
The different components can also be selected to be formatted. The steps below demonstrate a selection of 
customisation.

A legend or key can be added.

Objects and backgrounds 
can be filled with solid fills, 
gradients or patterns.

Elements can be 
resized.

Headings and text can be styled 
using the Formatting toolbar.Axis titles can be added.

Using the model created in Activity 5, create a chart that represents the capacities of different storage devices, as requested by 
Abacus in the introduction to this unit.

Activity 6

Importing a chart into another program
Once created, a chart can be copied into another program by simply using the Copy and Paste command (or 
Paste Special for more options). Paste Special can be found from the main or Edit menu.
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Add your chart to your training document. If you have used columns; keep the size within one column and make sure the chart has 
a title and brief description. Make sure that you save all your work afterwards.

Activity 7

You should now be able to:
� create a simple spreadsheet and save it with a suitable filename in a suitable location
� set the page size, margins and orientation of a spreadsheet
� use the header and footer to add useful information
� add accurate data to create a simple chart and insert it into a word processed document.

Review and revise P
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Background
Your employer has asked you to carry out the following tasks before you move onto your next project:
� Print the storage devices and media training booklet as a full colour sample, ready for final checking 

before going to print.
� Your spreadsheet must be printed so that its layout, functions and formulae can be checked.
� Having already seen samples of your work and being impressed with the quality, your employer has asked 

you to produce an additional information leaflet.
� Exporting documents into alternative formats, depending on 

end-user requirements.

In this session, you will find information on the following:
� checking your completed documents for spelling mistakes and visual 

errors
� using test data to check that a spreadsheet model works correctly
� printing options for each of your documents, including numerical 

and formula printouts for your spreadsheet model.
� exporting documents into alternative formats, depending on end 

user requirements
� using compression tools to combine multiple files into one package, 

suitable for emailing to colleagues.

Spelling and grammar checks
All office software packages have some sort of spelling and grammar checking facilities built in. The following 
steps will guide you through how to check your documents.

Word processing software
The Spelling and Grammar tool can either be found from the 
Review section of the main ribbon or by simply right clicking over the 
incorrectly spelt word.

The grammar check works in exactly the same way.

When using the automated spelling 
and grammar checks of any office-
based software it’s important to 
remember that these tools are not 
guaranteed to correct all mistakes and 
understand the grammatical variations 
of every language. They should be 
combined with visual proofreading 
and it is essential to ensure the 
correct language option has been 
chosen before using these tools.

Tip

Although the functionality hasn’t 
changed, sometimes the tool name 
does. For example in the latest version 
of Microsoft Word, spelling and 
grammar functions are found within 
the Editor tool.

Tip

SESSION 3.7  Final document checks and 
presentation
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Spreadsheet software
The process is the same here, although there is no grammar check, just spelling.

Use spelling and grammar tools to check the training guide and spreadsheet model you have created, correcting any mistakes that 
are identified.

Activity 1

Proofreading and visual checks
Software spelling and grammar checks can make mistakes, and you will 
miss obvious errors just by reading your work too often. Proofreading 
and visual checking is the process of letting someone else read and 
analyse your document – ideally someone who has had nothing to do 
with its creation and who may fit with its intended audience. The easiest 
way to do this is to pass out printed copies of your work to friends 
and colleagues and ask them to annotate it (make notes on the page), 
indicating any errors they find and making suggestions about its layout 
or content.

These checks prevent a poor experience for the eventual reader and can 
also allow any additional pagination to be carried out if required. This may 
include the following:
� Check for inconsistent line spacing that may be off-putting for the 

reader.
� Remove any blank pages or slides not being used.
� Remove widow/orphan elements.
� Look for inconsistent or incorrect styles being used within the same document.
� Where tables and lists have been used, ensure they don’t cross from one page or column to another.
� Incorrect spelling, not picked up by software, names for example.
� The removal of inconsistent character spacing or sentence case.
� Two adjacent numbers could be reversed, or transposed, and this would not be picked up by a computer 

but could spoil a spreadsheet or telephone number. 

Print a copy of your training guide. Swap with a classmate to look for any errors in content or layout. If possible, give a copy to a 
family member and ask them to check your work, too. Make changes to your document based on the feedback you receive.

Activity 2

Pagination is the process of 
analysing the content of any 
document and making decisions 
on how it should be divided into 
separate pages, either electronically 
or printed. Widows/Orphans within 
this type of publication relate to 
content spilt across pages, such as 
the last sentence of a paragraph or 
a subheading sitting at the bottom 
of a page and its related content on 
the next. Although not grammatically 
incorrect, these can produce a poor 
experience for the reader.

Language
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Spreadsheet testing
Before passing on any spreadsheet model for others to use, it should be tested to make sure that the results 
it produces are accurate and that any errors are resolved. The simplest way to test the functions and formulae 
of a spreadsheet is to use sample data that can be easily confirmed. The following examples will guide you 
through testing formulae.

Calculating the total in the example shown is 
done by using the SUM function. It calculates 
the answer to be 323.56 MB, but without using 
a calculator this could be difficult to confirm.

By changing all the data to 5s and 10s, the 
answer can be easily confirmed:

5 + 5 + 5 + 5 + 5 + 10 + 10 + 10 + 10 + 10 = 75.

Please note that this example is slightly different from the one you created in the previous session.

Create a new simple spreadsheet model using data of your choosing that includes the 
SUM function. You can also try other functions that subtract, divide and multiply. See 
the Tip box on page 132 or the reference chart in the digital download (in the Extra 
support folder) for help with these functions. Carry out tests for each formula using 
sample data wherever possible. If any of your tests produce an error or an incorrect 
answer, examine that area with a friend to rectify the problem.

Activity 3

Printing options
When printing any piece of work, there are a number of options to consider:
� Should it be in colour or black and white?
� How many pages should be printed to a sheet?
� What elements need to be seen in the printed version?
� Does the printer setup match the computer’s document layout?
� Does the document need collating?

The following steps will guide through the options available to you.

Most testing errors are the result of 
an incorrect cell reference or a simple 
typing mistake. Using basic sample 
data allows such errors to be found 
more quickly.

Tip
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Word processing software
The following options are used in most office software packages. The following options are found by 
selecting File > Print or using a keyboard shortcut Ctrl + P .

You can change the number of copies to be printed. 
Always do a test print before printing multiple copies.

If you are attached to a network, you may have a choice of 
printers. Choose the most appropriate.

When printing copies of a multi-page document, pages 
can be collated either to print the whole document 
repeatedly or to print multiples of the first, then the 
second page, and so on. To save paper, multiple pages 
can be fitted to one sheet.

The default setting will print all pages, but you can type 
in individual page numbers (separated by a comma) or 
ranges of pages (separated by a dash).

Spreadsheet software
Spreadsheet software uses the same general options as those above, but it also has additional options 
relating to which specific elements of the spreadsheet are printed.

From the Print window, users can select whether to print the page they are currently working on, the whole 
workbook (if the document uses multiple worksheets) or a specific area already selected.

Additional options can be found in Page Setup. Refer to pages 122 to 
125 for a reminder. Most are self-explanatory. However, the Row and 
column headings option is useful when printing spreadsheets in 
formula view.

At times you will want to switch 
between the datasheet view and 
the formula sheet view. The Excel
keyboard shortcut is Ctrl + ` to 
toggle between the views. Or, select 
Formulas from the main menu and 
use the Show Formulas button.

Tip
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Print a copy of the following documents produced for Abacus International Bank:
� The storage devices and media guide
� The storage space spreadsheet model in numeric view
� The storage space spreadsheet model in formula view, with gridlines, row and column headings and fitted to one page.

Keeping in mind the printing facilities which you have access to, choose the most relevant settings in regard to page layout, colour 
and quality. Once complete, make sure all your work is saved with a suitable filename and location.

Activity 4

Your employers are very happy with your work. They are impressed with the way you have combined text and images in the 
training document and they have asked you to create an additional document before you move on to your next project. They would 
like you to create an information sheet that outlines the basics of modern banking methods to students who will be visiting the 
bank hoping to work in the industry in the future. Refer to the information in Session 3.3 on the devices and methods used in 
banking, and create a leaflet that students can take away with them.

Activity 5

Exporting and compressing documents
Having now created three documents for your employer you have been asked to provide electronic versions 
that can be sent electronically anywhere in the world. Rather than sending individual files it makes sense to 
combine the documents into a single compressed format that not only saves file space but means only a 
single file needs to be either passed on electronically or emailed as an attachment.

To ensure maximum compatibility you have been asked to create portable document format (PDF) versions of 
the files just in case the office applications your colleagues use are slightly different to yours.

Creating a PDF version of your word-processed documents
From the File tab, select the Export option and Create PDF/XPS.
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Creating a compressed package of multiple files
Using File Explorer, make sure all the files are together in one folder, select the folder and select Share and 
then Zip. This will create a single compressed file in the same location that contains all the files you need to 
share.

To extract, or un-zip, files from a compressed folder
Using File Explorer, select the compressed folder, select the 
Compressed Folder Tools tab and select Extract All.

Create a single compressed folder of all the files you have created for your employers including:
� the word-processed documents outlining storage devices and media, and modern banking methods
� the data model of device storage capacities
� PDF versions of all three files for easy viewing.

Activity 6

You should now be able to:
� check any document for spelling and grammar mistakes and correct them using software facilities 

and proofreading to identify any problems before a document is printed
� use sample test data to test a spreadsheet model and confirm that the functionality you have added 

works correctly
� use the most suitable printing options in word processing and spreadsheet software to meet the 

needs of the audience
� use compression tools to combine a selection of documents into one transferrable file that also 

reduces its overall file size.

Review and revise

When compressing files and folders 
you may see examples using either 
ZIP or RAR file extensions. Both are 
compression file types with one 
key difference. ZIP compression 
is commonly used and built into 
operating systems, including Windows 
and Apple, whilst RAR is a proprietary 
file format that requires third-party 
software to use it.

Real world

Creating compressed zip folders 
of multiple files is very useful but 
unfortunately it is also a favoured 
method of sending email attachments 
containing viruses, disguised as files 
the recipient has requested. It is 
important to always check and scan 
any suspicious email attachments and 
if in doubt, delete them.

Real world
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A poster needs to be created to advertise this 
concert trip.

1 Using a suitable software package, load the file 
ConcertPoster.txt, which contains details for 
the trip that Miss Brown is organising. 

2 Work out which lines of text are headings and 
which are details and apply suitable font, style, 
sizes, paragraph spacing and colours for them.

3 Search the internet to find the URL for the home 
page of the National Youth Orchestra. Add this 
URL to the poster in a suitable position.

4 Search the internet to find a picture of the inside 
of the Birmingham Symphony Hall, including the 
organ. Download and save this image.

5 Place the image saved at step 4 in the document 
so that it creates a banner across the top of the 
page. Resize and crop the image to achieve this, 
but make sure the aspect ratio is maintained.

6 Search the Cambridge Assessment 
International Education website (https://www.
cambridgeinternational.org/) to find the URL 
of the page for the Cambridge IGCSE Music 
syllabus. Add this complete URL to the poster in 
a suitable position.

7 Save the poster in two different file formats, 
one in the native software it was created in and 
another as a PDF document.

8 Using a suitable software package, load the file 
Coach.csv. The spreadsheet shows the seating 
plan of the coach with two seats either side of the 
aisle (column C). A booked seat has the person’s 
name in the cell. A “1” (one) in a cell means that 
the seat has not yet been booked.

9 In cell H5, use the SUM function to add up the 
values in cells A1 to E12. This will tell you how 
many seats are still not booked.

10 In cell H8, create a formula that uses the values 
in cells H2 and H5 to calculate the number of 
seats that have been booked.

11 Enter 4 into cell H11.

12 In cell H14, create a formula, which uses the 
values in cells H8 and H11 to calculate the 
amount of money collected (seats booked 
multiplied by the cost per seat).

Some practice questions
Miss Brown is organising a school trip to a music concert, which includes one of the 
set pieces for the Cambridge IGCSE Music syllabus that her students are studying. 

What have you covered?
In the three practical sessions about document production, you have:
� revised and extended your skills for working on documents covered in Unit 1
� entered and formatted text
� created, edited and completed tables
� imported and placed a chart that had been created with a spreadsheet
� checked documents for errors of spelling or grammar.

In the practical session using a spreadsheet, you have:
� created a new spreadsheet and saved it with a suitable filename in a suitable location
� set the page size, margins and orientation of a spreadsheet
� used the header and footer to add useful information
� added text and numerical data to a spreadsheet
� used the SUM function to add values across a range of cells
� created and edited charts to represent data visually
� formatted and styled all elements of a spreadsheet to meet users’ needs and produce a 

professional looking model
� used sample test data to test a spreadsheet model and confirm that the functionality you have 

added works correctly.

Having created two types of practical document, you have:
� exported office-based documents as PDF documents to maximise their audience
� compressed and zipped a selection of files into one file, suitable for transmission.

3 Practical review
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13 In order for the trip to go ahead, Miss Brown 
has to have 34 people on the coach.

Type into cell H17: =IF(H8>33,"YES","NO")

After entering this, cell H17 should display “NO” 

This is known as an ‘If’ statement, and you’ll 
learn more about this in Unit 6. Alternatively 
you can look at a description on the 
spreadsheet features and functions reference 
chart on the digital download (in the Extra 
support folder).

14 Look carefully at the numerical values in the 
cells down column H.

Marianna Rodriguez wants to book seat D8. 
Enter Rodriguez into cell D8.

Check that the values in cells H5, H8 and H14 
all change.

15 Enter ‘White’ into cell E12.

Cell H17 should now indicate ‘YES’. If this does 
not happen, go back and check your formulae, 
starting with cell H17.

16 In the page header, enter: Coach bookings for 
music concert.

17 Use the text alignment buttons to centre all the 
data in the spreadsheet.

18 Adjust the margins and cell widths so that all 
the data in the cells is fully visible and so that 
the printout will fit onto one A4 sheet with 
portrait orientation.

19 Save the spreadsheet as CoachBookings.

20 Create a zip folder of the documents you have 
created for Mrs Brown so that you can easily 
email her all the files.

Progress check

Aiming for good progress

As well as the points listed under ‘Aiming for 
good progress’ in Unit 1, you can:

Word processing
� enter and format text
� create and complete tables
� check documents for errors of spelling or 

grammar
� print your work in a suitable size and orientation 

for the audience
� export files as PDF versions to maximise their 

viewing potential.

Spreadsheets
� create a new spreadsheet and save it with a 

suitable filename in a suitable location
� set the page size, margins and orientation of a 

spreadsheet
� use the header and footer to add useful 

information
� add text and numerical data to a spreadsheet and 

format it to suit the users’ needs
� use the function SUM and create simple 

formulae within a spreadsheet
� create charts to represent data visually and 

import them into a word processed document
� use sample test data to test a spreadsheet 

model to confirm that the functionality you have 
added works correctly.

Managing your files and folders you can:
� use suitable file and folder names
� compress multiple files as a single zipped folder 

to help transfer files electronically.

Aiming for excellent progress

As well as the points listed under ‘Aiming 
for excellent progress’ in Unit 1, you can:

Word processing
� enter and format text
� create, edit and complete tables
� check documents for errors of spelling or 

grammar
� confidently export work in the most suitable 

electronic or printed format to meet the needs 
of the audience or target user.

Spreadsheets
� create a new spreadsheet and save it with a 

suitable filename in a suitable location
� set the page size, margins and orientation of a 

spreadsheet
� use the header and footer to add useful 

information
� confidently use the SUM function
� create charts to represent data visually, importing 

them into a word processed document
� format and style all elements of a spreadsheet 

to meet users’ needs and produce a 
professional-looking model

� use sample test data to test a spreadsheet 
model to confirm that the functionality you have 
added works correctly.

Managing your files and folders you can:
� use appropriate file, folder and sub folder names
� compress and share electronically multiple files 

as a single zipped folder to meet the needs of 
the audience.
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